TEACHING WITH MICROSOFT WORD

Word provides a writing instructor with a wide range of ways to integrate word processing into the classroom. We have included a list of some of the most popular options here, but this list is certainly not exhaustive.

OPTION 1: DEVELOPING CLOSE READING SKILLS

Students can work individually or in groups, responding to guided questions about readings, or they can use the formatting and highlighting features of Word to visually ‘mark-up’ a passage. By taking a passage out of context, students can be forced to look much closer at the rhetorical “clues” provided in the text.

SAMPLE EXERCISE: CLOSE-READING TEXTUAL FRAGMENTS

(Cindy Landwehr)

- Read the fragment of the story I've given you at least three times and very carefully. Don't worry that it seems “out of context”—it is, and this may help you notice details that you wouldn't notice if you were just reading for plot.
- Identify all the details or collections details that seem significant, troubling, important, or intriguing to you. These could be images, objects, specific words or phrases, ideas, relations. Mark on the paper as much as you want to—go ahead and underline words and make notes in the margins.
- Now, type out a list of the actual phrases or sentences that you have identified, and one by one reflect on what interests you about the details you have chosen. What is enlightening or puzzling or interesting about them? What do they reveal about the character(s) involved—judging from the passage that you are interpreting, how would you describe each character's state of mind, personality, characteristics, and relationship with the other character(s)? What seems to be happening—plot-wise—in the story at this point?
- You will have the rest of the class period to compose your response. When you are finished, make sure to read over for things you may want to change or make clearer or add to, and of course proofread for typos and mechanical errors. You will be printing this out at the end.

INTEGRATED OPTION: Including the passage in the file would allow students to mark up the passage on-line, eliminating the need for retyping phrases.

OPTION 2: USING MICROSOFT'S “INSERT PICTURE” FEATURE TO STIMULATE DISCUSSION AND TEACH VERBAL/VISUAL LITERACY

Using Word's “Insert Picture” function is an excellent means to encourage close reading as well as to distinguish variations in student initial responses to literary texts is the interpretive pairing of graphic with verbal imagery.

SAMPLE EXERCISE: JUDGING BOOKS BY THEIR COVERS?

(Laurie George)

In the following example, a simple Google “Image” search for photographs used by Jon Krakauer in his book Into the Wild produced the following self-portrait of the book's protagonist, Christopher McCandless, a photograph that Krakauer reprinted as the first image (notably graphic, not verbal) inside the book's cover.
One of his last acts was to take a picture of himself, standing near a bus under the high Alaska sky, one hand holding his final note toward the camera lens, the other raised in a brave, beatific farewell. His face is horribly emaciated, almost skeletal. But if he pitied himself in those first difficult hours—because he was so young, because he was alone, because his body had betrayed him and his will had let him down—it’s not apparent from the photograph. He is smiling in the picture, and there is no mistaking the look in his eyes. Chris McCandless was at peace, serene as a monk gone to God.

(Krakauer, Into the Wild, 1996)

Downloading the image into a Word file and then pairing it with some of Krakauer’s verbal descriptions of the starving McCandless provide excellent pedagogical means of teaching assorted critical approaches to literature—that is, an instructor can pose questions to students that reveal biographical, cultural, and/or formalist reader predispositions toward the interpretation of literature, questions such as these:

- Why did Krakauer decide to include this picture (rather than the one of McCandless waving at the camera) and how does it complement/contrast with the verbal description he fashions when characterizing McCandless in the final stages of the young man’s life, starving to death in the wilderness that he had so idealized?

- Does the photographic self-depiction of McCandless mesh with Krakauer’s imagined verbal depiction of the young man’s final days, thoughts, and emotions? What matters about any variance in the two depictions—is one less “true” than the other? What does any difference reveal about Krakauer’s so-called journalistic objectivity?

Such questions provide an excellent means to start a discussion of any text, as students can be asked to “read” the photo in relation to any number of philosophical/theoretical approaches (Naturalism, Realism, or Romanticism, for examples) and contrast these ideals with the verbal textual representations before writing about them.

Undertaking these interpretive exercises in class, students are introduced to core concepts of visual literacy and reader-response theory and must address core questions:

- Do these graphic depictions enrich readers’ (difficult) pleasure by accompanying verbal text, or simply entertain and reproduce cultural stereotypes?

- Do graphic additions rob readers’ imaginations, which might otherwise conjure revelatory images of an altogether different kind?

**OPTION 3: USING MICROSOFT’S COMMENT TOOL TO ANNOTATE**
As much literature can be found online (Amazon.com publishes lengthy excerpts of even the most recent novels in online advertisements), an excellent means of teaching students to read closely and annotate thoughtfully (not just circle and underline) is to copy and paste a portion of any text (poetry, prose, whatever) into a Microsoft Word read-only document, have students make personal copies of the document in class, annotate the excerpt, and then project students’ annotated texts for discussions of the text, either in the computer classroom or in the seminar room via the laptop.

**SAMPLE EXERCISE: ANNOTATING TEXT WITH MICROSOFT WORD**

(Laurie George)

Note: The collaborative nature and in-class locale of this exercise is important, as students can easily and readily access databases from the English Library Web page (http://www.lib.washington.edu/subj/English/) to provide biographical, etymological, and socio-historical glosses to a variety of terms and allusions in the text. All enrich class discussion and broaden students’ horizons about critical approaches to literary interpretation.

On Thursday we’ll be spending the first half hour of class annotating an excerpt of “The Lottery,” using various databases available to us via the UW Library—specifically, Literature Resource Center (to find biographical information about Jackson), Oxford Reference Online, and English Language Dictionaries.

The goal is not to find critical articles that provide a story interpretation for you, but for you yourself to build an interpretation of Jackson's story by stopping at any word, phrase, or allusion that she chooses to include. Do this remembering that Jackson started with a blank page and was fastidious about the words she used to craft characterizations, setting, mood, conflict, etc.—always remember that she had choices, that she had designs on you as a reader to think and feel a certain way about the cast of characters and how things play out during the course of the plot. Words are her essential means of gaining your attention, especially through language connotations, denotations, and allusions.

When you find a word, also use the thesaurus feature in Word (in the Tool bar above, select Tools > Language > Thesaurus) to consider how Jackson might have chosen other words that would have attracted/distracted your attention to different character attributes and themes.

So in the first half hour tomorrow, I will have you comb the first part of this text, its exposition, highlighting words and phrases in which to insert your annotations, your commentary.

To do this:

- Highlight the word or phrase in Jackson’s story that you are researching
- Find the Tool Bar at the top of the page and left click on Insert
- Drop the cursor down to Comment, selecting it
- Keyboard your comment into the pop-up box that appears, briefly noting the information you researched and why you find it useful

Example:
OPTION 4: USING AUDIO TO FACILITATE TEXTUAL ANNOTATION

(Definition and sample assignment, Laurie George)

*Human speech is like a cracked kettle on which we tap crude rhythms for bears to dance to, while we long to make music that will melt the stars.*

Gustave Flaubert

Although instructors think most readily of using DVD clips in classrooms, not as frequently do we consider audio without the visual—any number of sites online feature audio clips of poetry, short stories, speeches, and novels read by the authors:

In the following exercise, students are asked in the computer classroom to listen to a writer’s oral rendition of their text as the students read the written rendition onscreen, and then respond in writing to their audiovisual reading of authorial voice.

Some background: because it is important in audio sessions to have students focused on listening rather than distracted by other considerations, students arrive at the listening session (such as the one described below) well versed in the differences between indirect and direct modes of literary address, as well as generic differences between memoirs and fiction.

Students are also well aware of the basic plot line of the selected text featured: in the case below, a 41-year-old man describes his class meetings of Alliance Francaise in Paris, a class he enrolled in willingly to learn French despite his fears that the pedagogical model would be less than collaboratively constructive. His fears are realized; his instructor proves to be extraordinarily abusive towards all the students in the class, whatever their race, gender, or ethnicity: discipline and punish is one way of encapsulating the thematic core of this David Sedaris essay.

Plot in mind, students are asked to listen to the text in the computer lab as they read the print text from the screens in front of them, and to insert comments (from the Insert column of the shortcut bar on Microsoft Word) as they read and listen. The exercise works best if the clip is replayed at least once, and better twice.

Here is one annotated edition from listening to the Sedaris reading of the first half of his essay “Me Talk Pretty One Day” (from the book on disk):
OPTION 5: USING WORD'S READABILITY TOOL TO EVALUATE TEXTS

Microsoft Word also includes a tool for checking a text's readability, whether that “readability” concerns a student essay, a critical essay, a wall graffiti note, a blog entry, a presidential address, a short story, a novel, etc.

This tool is therefore enormously useful for checking the stylistic profile of any professional- or lay-authored text, including the fictional styles of characters and personae penned from whatever actual or virtual source.

SAMPLE EXERCISE: EXAMINING TEXTS WITH WORD'S READABILITY TOOL

(Laurie George)

Any document saved into Microsoft Word can be scanned for certain “readability statistics” by configuring Word in the following ways:

<table>
<thead>
<tr>
<th>Word 2003</th>
<th>Word 2007</th>
</tr>
</thead>
<tbody>
<tr>
<td>On the Tools menu, click Options, and then click the Spelling &amp; Grammar tab.</td>
<td>On the Review pane, select Spelling &amp; Grammar.</td>
</tr>
<tr>
<td>Select the Check grammar with spelling check box.</td>
<td>Check the Check grammar box and click the Options button.</td>
</tr>
<tr>
<td>Select the Show readability statistics check box, and then click OK.</td>
<td>Select Proofing from the list on the left.</td>
</tr>
<tr>
<td>On the Standard toolbar, click Spelling and Grammar.</td>
<td>In the When correcting spelling and grammar heading on the right, check the Show readability statistics box.</td>
</tr>
<tr>
<td>Click OK.</td>
<td>Click OK.</td>
</tr>
</tbody>
</table>

Only after a text goes through the keyed-in process of running Spell Check does this program display information about the readability of the document—but it does, finally, and this is what it displays:
The most useful features of the tool relate to a student's editing concerns for their own writing or a student's need to analyze the stylistic features of a professional writer. Both goals apply to the three headings of “Counts,” “Averages,” and “Readability” in the following ways:

- In a student draft, does the text include enough words—or too many—slightly fitted or stuffed into paragraphs that match the writer's rhetorical goals for a given reading audience?
- In the professional text, does the variance of word averages indicate a kind of authorial style—for example, the minimalism of a Raymond Carver story? Alternatively, does a high count of words in a page of dialogue reveal verbosity in a certain set of characterizations?
- How many paragraphs are included in this passage—if there were more or fewer, would the emotional and logical effect on the viewer be different? Would the difference add to credibility in whatever fashion?
- If a character in a fictional work is speaking a piece labeled “readable” in this manner, how reliably literate is this character?
- If the character or the author writes in extremely brief or extensively long sentences, what does the simplicity or complexity of the style reveal about the character, or the author's style or the author's values?
- What about the character's or author's passivity or activity in sentence construction? What does this stylistic attribute reveal about the character or author—is the writer hiding culpability behind passive voice? Is the author implying thematically that a character is unwilling to take agency, the passive voice indicative of that resistance?
- If conventional criteria measure this writing excerpt as “low” in the conventional reading level of “Flesch-Kinkaid” grade levels, then what does this gradation imply about the readers' values or the evaluators' values concerning literacy?

**OPTION 6: BRAINSTORMING AND FREEWRITING**

Brainstorming and freewriting often work best when they are made a regular part of the class routine. Word makes it easy to do this. Some instructors start off every day in the computer classroom with a ten-to-fifteen minute freewrite or with an electronic journal response. Alternatively, students could be given time in class to brainstorm before a paper is due. Unlike a handwritten freewrite, both the student and the instructor can share the end product. Students can print out a copy or save a copy to disk, and instructors can review the class responses from their offices.

**SAMPLE EXERCISE: WORKING TOWARD AN INTERPRETATIVE THESIS**

(Laurie George)

During this class period, you will be working toward a strong, interpretive thesis based on the evidence and ideas you've already collected about your topic. The following steps are designed to help you get started in the thesis process; feel free to skip or alter them—whatever will help you most. Have the people near you read what you have written and advise you on it; ask questions, and offer suggestions. There's no need to be silent. Hold the mouse over highlighted text to see instructions on how to do various tasks. Remember to SAVE OFTEN.

**I. Topics**

Review your journal entry from last night and, in the space below, type in your “proto-thesis,” or a summary of what you think you want to write about. If you need a few sentences, that's okay; this statement is just a place to get you started.
II. Argument Brainstorm

As we've discussed in class, every argument breaks down into a number of sub-arguments—a series of subordinate ideas that are the building blocks of the larger argument. In the space below, begin to think about how your topic could be broken down. Start by looking at your topic statement above and listing off all the ideas that seem related to it. Or, if that doesn't work, try listing a series of questions that you think you would need to answer in a paper about that topic. List these ideas, sub-topics, and questions in the left-hand column of the chart. In the column to the right, list two or three pieces of evidence that might be useful in developing a paragraph about each sub-topic. Try, whenever possible, to be very specific about your evidence. Don't worry about whether or not you will use each one of these—at this point you are just generating ideas. If you run out of space, insert more rows in the table.

<table>
<thead>
<tr>
<th>Subtopics</th>
<th>Evidence</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

III. Speculations

Now, think carefully about the lists above. Generate a series of claims related to your topic that could serve as subtopics to organize and to develop your argument. Your goal here is to construct claims; write out complete sentences, as if these were going to be the topic sentences of your paragraphs. Use the top box to brainstorm freely, and come up with as many ideas as possible. Once you generate your list, cut and paste different claims into the bottom boxes, and experiment with organizing your ideas in different ways.

<table>
<thead>
<tr>
<th>Brainstorm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outline 1</td>
</tr>
<tr>
<td>Outline 2</td>
</tr>
</tbody>
</table>

IV. Thesis Statements

Now that you have worked though your ideas and listed out both your evidence and possible organizational strategies, try to come up with two or three possible thesis statements. Look carefully at the lists you have made; you may have several more thesis options that you originally thought.

<table>
<thead>
<tr>
<th>Thesis 1:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thesis 2:</td>
</tr>
<tr>
<td>Thesis 3:</td>
</tr>
</tbody>
</table>

V. Peer Commentary

Review the worksheet, especially sections III and IV, and then comment on the thesis statements above. Consider whether or not the thesis seems broader than the ideas expressed in the brainstorming section. Does it seem arguable? How clear is it? Does it oversimplify? Is it too complex? Be sure to write your name in the gray box above your comments.

<table>
<thead>
<tr>
<th>First Reviewer:</th>
<th>Second Reviewer:</th>
</tr>
</thead>
</table>

If you want to work with these reviews at home, be sure to print a copy of this file or save a copy to disk.

**INTEGRATED OPTION:**

Additional instructions for how to add more rows to tables, print and save can be added using the comment function. When students move the mouse to the highlighted text, these instructions appear in a comment window.

**OPTION 7: PEER REVIEWS AND SELF ASSESSMENTS**
Word gives you a number of options for peer-reviews and for student self-assessment. Students can read ‘hard-copies’ of each other's papers, then write a peer review, assessing the strengths and weakness of the argument. Or they can comment on the paper electronically, making a copy of their partner's file and inserting comments into the document itself. Word provides a number of features to help make their inserted comments stand out. Students can use the Comment feature or the Highlight feature, described below, or simply place all their comments in bold or in capital letters.

SAMPLE EXERCISE: ON-SCREEN PEER EDITING

(Laura Kuske)

Today you are going to workshop your peer's paper and provide advice on how he or she could strengthen the argument. This time, your review will focus especially on organization, evidence, and paragraph structure. You will be working in pairs and using the prompts below to guide your responses to your partner's paper. Before you begin, you will need to follow these initial instructions.

Getting Started

Step 1: Exchange file names with your partner, and open his or her document. Double-click on the “Word” icon to open Microsoft Word. Select Open from the File menu, and choose your partner's file from the directory list.

Step 2: Make a personal copy of your partner's file. Since you will be making changes to the file, you want to make sure you are working from a COPY, not the original. To do this, Select Save As from the File menu, and rename the file as directed by your instructor.

Step 3: Tell the computer who you are. The person you are reviewing will want to know who said what; you need to tell the computer who you are so it can attribute your comments to you. To do this, select Options from the Tool menu. From the window that pops up, select User Information. Type in your name and initials at the prompt.

Step 4: Begin your review. To insert comments, highlight the text you are commenting on and select Comments from the Insert menu. Type in your suggestions in the window that appears at the bottom of the screen. To add end comments, simply scroll to the end of the document, click the mouse at the bottom of the text, and begin typing. Use the following questions as your guide, and be sure to save your work periodically.

The Peer Review

1. Read the paper over once, fairly quickly. Do not make any comments. You are merely trying to formulate a general impression of the argument as a whole. At the end of the paper, describe your initial response to the argument. Without referring back to the essay, see if you can summarize the main points. What does the paper seem to argue? How persuasive did you find the argument? Thinking back, can you remember the logic of the argument, or is it all a blur? Was there anything about the paper that grabbed your attention? Were there claims that you strongly disagreed with or found insufficiently supported?

2. Reread the paper slowly and carefully, and comment on the introductory paragraph. First, find the thesis, and underline it. Next, insert a comment evaluating its effectiveness; consider both the myths and purposes of a thesis that we discussed in class last week.

3. Next, take a closer look at each body paragraph, and identify two that you feel might benefit from further revision. Considering all the structural issues we discussed today, think carefully about how the paragraph is put together:

   Is there a topic sentence near the beginning of the paragraph? If so, highlight it, and comment on how well it fulfills its role. Does it present a concept or a detail from the story? Does it connect to the thesis?

   Does it have a clear relationship to the ideas developed in the preceding paragraph? How well does it capture the main idea of the paragraph? If there is no clear topic sentence, comment on what you think the topic of the paragraph might be.

   Look at the body of the paragraph. Insert your comment(s). Consider what type and how much evidence is used; is there enough? Is there too much evidence? Are claims being developed over the course of the paragraph? Does the writer do more than merely summarize from the story? Does he or she present you
with specific details from the text? Does the writer explain what the evidence proves and WHY?

4. Insert a comment at the end of the paragraph considering the paragraph's conclusion. Does the paragraph offer one? Does its conclusion offer any new perspective on the evidence and on how it relates to or develops the ideas expressed in both the topic sentence and in the thesis? Does the conclusion seem forced or obvious? Does it seem unrelated to the evidence offered? Do you see how the conclusion can be derived from the evidence offered?

Printing Your Comments

When you and your partner have finished commenting, you can print out a copy of the paper with all the comments. From the File menu, select Print. To select this option, you must use the menu; do not use the print icon. In the window that pops up, click on Options. Make sure that there is a check-mark next to Comments in the list that appears. If the check is not there, simply click the mouse in the box to insert the check-mark. Now, click OK to return to the print menu. Click OK again to send your file to the printer.

SAMPLE EXERCISE: SELF-ASSESSMENT OF ORGANIZATION IN FILM ANALYSIS

(E.L. George)

In this revision of your essay, I'd like you to assess your own draft (before a classmate moves to your workstation to respond):

1. Make a copy of your essay and name it movie#OR

2. In the copy, above the title, use 14 pt. bold faced font to state your thesis (even if it appears again in the introductory paragraph). Then number the paragraphs in boldface in the space following each paragraph (create space as you need to).

3. Reread each paragraph, and in the space you've created, type out the main claim of the paragraph (if you use topic sentences in your paragraph, you would rewrite the topic sentence).

Examine the list, and ask yourself the series of questions noted in The St. Martin's Handbook.

What organizations strategies are used? spatial? chronological? logical? [compare & contrast?]

Are they used effectively and consistently?

Do the main points clearly relate to the thesis and to one another? Are any of them irrelevant [disunifying the essay]?

Can you identify any confusing leaps from point to point?

Do you need to provide additional or stronger transitions?

Can you identify clear links [either through a logical shift of ideas or obvious transitions or repeated words ] between paragraphs and ideas? Do any others need to be added?

Have any important points [about the likenesses and differences of movie x on corporate life vs. movie y] been left out? (63)

SAMPLE EXERCISE: SELF-ASSESSMENTS USING AUTO-SUMMARY

(Laura Kuske)

Author:

Paper Title:

Today, instead of reviewing a partner's paper, you are going to do an extended assessment of your own writing... with a little help from Microsoft Word. Part of the point of today's exercise is to expand our discussion of paragraph structure and argumentative logic to include transitions -- which means that we are going to begin focusing on how to clearly express the connections BETWEEN ideas and between paragraphs. In order to begin to see why transitions are important, we are going to spend the first part of class today working on creating an abstract of our arguments. Ideally, an abstract can be formed by collecting the main
ideas of an argument into a single paragraph. But for an abstract to MAKE SENSE, these ideas have to be expressed in ways that make the relationships between ideas clear, while still accurately reflecting the specific content of the paragraphs. That can be quite a challenge, and the attempt can often reveal quite a bit about the places where the connections are not yet clear enough in the larger argument.

What we do today may seem a little confusing at first, because you are going to move back and forth between two Word files -- this worksheet and your own paper-- and we are going to try out a few 'advanced' Word commands. If you have problems or get lost along the way, just raise your hand and I'll help get you back on track.

Getting Started

1. Begin by opening the file containing your draft. Do not close this worksheet before opening your paper. You will need to have BOTH files open to do this exercise. To move between the two files, click on the Windows menu and select to file you want to look at.

2. Once your paper file is open, select AutoSummarize from the Tools menu. AutoSummary will review your paper, collect what it takes to be your main ideas, and write an abstract of your paper. From the window that appears, select the option to hide everything but the summary, and set the percentage at 10%. Click OK. Word will create an abstract of your paper. Although the rest of your paper will disappear, it is still there. You may need to delete a few extra paragraph returns to format the summary. It should appear as a single paragraph.

Creating/Critiquing/Revising your Computer Generated Abstract

1. Read carefully through the summary Word created. Does it seem accurate? Does the abstract read smoothly or is it choppy, abrupt or confusing? Pretend, for a moment, that this was not computer generated, but something written by you to be submitted (for instance) on the class Web page. Critique the abstract in the space below. Would you submit this abstract as representative of your paper and your writing? Why or why not? How would you revise it?

Comments:

2. Now, return to your paper, and increase the percentage of the text Word uses to create the AutoSummary to 15%. Reread the summary. Keep playing with the percentage until you have what you consider to be the best 'raw material' for an abstract of your paper. You will be editing and revising this, don't worry if you have to include extra material to get in all the ideas you want to include. Cut and paste the text from your abstract here.

Abstract:

3. You are going to revise this material in a moment, but first, take a look at exactly what parts of your paper the computer selected to create your abstract. To do this, return to your paper file and click OK to clear away the summary and return to the argument itself. Select AutoSummarize again, but this time, select the option to highlight key points and click OK. Set the percentage control window to the same percentage you used to create your abstract. Scroll through your paper and observe what parts of your paragraphs--and how much of the paragraphs-- the computer is using. Do the computer's selections reflect the topic sentence/conclusion pattern you might expect? How much 'other' material did you have to include to get a complete outline of your argument? Did the computer skip over some of your topic sentences and conclusions? Why? Comment on the patterns you notice and reflect on what they might suggest.

Comments/Observations:

Name:

Now cut and paste the raw material above into the box below and revise it into a concise and accurate abstract for your paper. Your abstract should be no more than 12-15 sentences (approximately 1 to 2 sentences per paragraph). It should provide a reader with a quick summary of all your main points, and the ideas should 'flow' together smoothly. It should not read like a list. It should read like an overview of an argument.

Revised Abstract:

When you are done, print out a copy of this page (only this page.), and a copy of your paper. You will be giving a copy of your paper and your abstract to a peer partner to review.
OPTION 8: WRITING WORKSHOPS

Word offers a range of powerful tools to help workshop writing, especially when used in conjunction with the overhead projector. Word allows you to highlight text in different colors, track editorial changes made to a document, or move text around in order to try out a variety of organizational or stylistic strategies.

SAMPLE EXERCISE: GROUP HIGHLIGHTING

(Kimberlee Gillis-Bridges)

Students participated in the following writing workshop during the class preceding the final draft due date. The essay assignment asked students to analyze a single scene from one of three early horror films, focusing on the narrative and cinematic elements at play in the scene. Before the workshop, I created a document featuring excerpts from students' papers as well as links to digitized video clips of the scenes. The excerpts represented the three main problems students had with their drafts: their paragraphs tended to be diffuse discussing several technical elements that served different functions; paragraphs often had little discernible connection to the thesis; and formal film terminology was absent or misused.

As they viewed the projected essay excerpts, the class analyzed weaknesses and developed strategies for revision. During the workshop, students asked to view the linked clips to confirm details or to point out cinematic elements the writer had missed. I served as recorder, using Word's highlighting function to mark passages as directed by the students. Writers whose paragraphs we analyzed could copy their marked passages and paste them into another document; a number of writers did so during the workshop, taking notes on their peers' comments, then saving the marked passage once the class had completed the review.

The following example demonstrates how students marked the excerpts:

Scene: Dracula; scene in which Dracula and Van Helsing Meet

Writer's Thesis: The scene separates Dracula and Van Helsing from the other characters as it pits the two against one another in a struggle between evil and good.

Explanation of Highlighting: The yellow highlighting marks a passage connected with the first part of the thesis—that technical elements of the scene separate Dracula and Van Helsing from the other characters. Although the passage suggests that a pattern of alternating close-ups distinguishes these two characters from other characters in the scene, the class thought that the idea needed further explication, perhaps in another paragraph. The green highlighting indicates an idea that the class thought detracted from the analysis in the rest of the paragraph. The blue highlighting marks a passage the class viewed as connected to the thesis. Students suggested that the writer make this passage the focus of the paragraph. They also suggested that the writer connect the editing of the close-ups and the issue of knowledge. Van Helsing's growing knowledge is conveyed through editing, and it is this knowledge that pits him against Dracula.

SAMPLE 2: STYLE IMPOSTERS

(Karen Kupka)

Read through the following passages carefully, using Word's highlighter to note the distinctive features of the writer's style. After you think you've grasped the stylistic differences between the two passages, try
impersonating both authors. Pretend that you are Hemingway, and rewrite the excerpt from Carter’s The Bloody Chamber in your own inimitable style. When you’re done with that, transform yourself into Carter and elaborate on A Moveable Feast.

I knew how severe I had been and how bad things had been. The one who is doing his work and getting satisfaction from it is not the one that poverty bothers. I thought of bathtubs and showers and toilets that flushed as things that inferior people to us had or that you enjoyed when you made trips, which we often made. There was always the public bathhouse down at the foot of the street by the river. My wife had never complained once about these things any more than she cried about Chevre d’Or when he fell. She had cried for the horse, I remembered, but not for the money. I had been stupid when she needed a grey lamb jacket and had loved it once she had bought it. I had been stupid about other things too. It was all part of the fight against poverty that you never win except by not spending. Especially if you buy pictures instead of clothes. But then we did not ever think of ourselves as poor. We did not accept it. We thought we were superior people and other people that we looked down on and rightly mistrusted were rich. It had never seemed strange to me to wear sweatshirts for underwear to keep warm. It only seemed odd to the rich. We ate well and cheaply and drank well and cheaply and slept well and warm together and loved each other.
--Ernest Hemingway, A Moveable Feast

Revision:

...for the opera, I wore a sinuous shift of white muslin tied with a silk string under my breasts. And everyone stared at me. And at his wedding gift. His wedding gift, clasped round my throat. A choker of rubies, two inches wide, like an extraordinarily precious slit throat. After the Terror, in the early days of the Directory, the aristos who escaped the guillotine had an ironic fad of tying a red ribbon round their necks at just the point where the blade would have sliced it through, a red ribbon like the memory of a wound. And his grandmother, taken with the notion, had her ribbon made up in rubies; such a gesture of luxurious defiance. That night at the opera comes back to me even now...the white dress; the frail child within it; and the flashing crimson jewels round her throat, bright as arterial blood. I saw him watching me in the gilded mirrors with the assessing eye of a connoisseur inspecting horseflesh, or even of a housewife in the market, inspecting cuts on the slab. I’d never seen, or else had never acknowledged, that regard of his before, the sheer carnal avarice of it; and it was strangely magnified by the monocle lodged in his left eye. When I saw him look at me with lust, I dropped my eyes but, in glancing away from him, I caught sight of myself in the mirror. And I saw myself, suddenly, as he saw me, my pale face, the way the muscles in my neck stuck out like thin wire. I saw how much that cruel necklace became me. And, for the first time in my innocent and confined life, I sensed in myself a potentiality for corruption that took my breath away. The next day, we were married.
--Angela Carter, The Bloody Chamber

Revision:

OPTION 9: REVERSE OUTLINES

Word also provides a range of outlining features that allow students to take a paper and convert it into an outline. An outline can help students to see the organizational structure of their papers in a "bare bones"
SAMPLE EXERCISE: REVERSE OUTLINE

Step 1: Read the following paper. As you finish each paragraph, type out what you think the most important idea (in other words, the thesis) of the paragraph is. What is the general claim of the paragraph? Be sure to write out the thesis in a single, grammatically correct sentence.

Despite appearances, I believe that Imogene & Marya's friendship is not the most important thing in Joyce Carol Oates's story, "Theft." No character in the story has as important a role as Marya, but her friendship with Imogene does not play the most important role in Marya's life. Therefore that friendship cannot occupy the most important part of the story. While this friendship concerned Marya a lot, she eventually discovered that other things--her work and especially her writing--played a much more important role in her life. Marya gave up her friendship with Imogene because it took up too much time, time in which she could do more important things like writing. Marya saw writing as the most important thing in her life because writing overcame the destructive effects of time, while friendship just passed the time.

THESIS OF 1st PARAGRAPH:

It's hard to say exactly why Marya wanted to be Imogene's friends, but whatever the reason was, it wasn't the most important thing in Marya's life. Marya of course didn't initiate the friendship. Imogene pursued her. Marya never planned to be Imogene's friend; it happened to her like an accident. But Marya had some curiosity towards Imogene. Before Imogene ever approached her, Marya found herself staring "at the blonde girl in her political science class" who wore "a handsome camel's hair coat" and "an engagement ring with a large square-cut diamond" (476). This attraction, however, didn't seem to have any reason, or at least any particular importance. Marya throughout the story stared at a lot of people, but doesn't end up friends with any of them, except Imogene. Again I would say the friendship depended more on Imogene than Marya.

THESIS OF 2nd PARAGRAPH:

Though her relation with Imogene confused her for a while, Marya came to realize that work held more importance for her. "It occurred to her with a chilling certitude that every moment not consciously devoted to her work was an error, a blunder" (487). Marya worried constantly whether she did enough work. This didn't mean her work at the library. If anything, she regretted the time her job took from her. What worried her was schoolwork. She wanted to work hard at it. She even enjoyed it. But fear motivated her as well. She thought nothing mattered as much as success, even her own health. She felt that only "one's personal accomplishment" (493) mattered in life. In the story two kinds of accomplishment mean the most to Marya: school and writing. As I will explain later, because of the problem time created in her life, writing proves more important than anything else.

THESIS OF 3rd PARAGRAPH:

What created this preference from writing over schoolwork was her attitude toward time. The idea of time kind of scared her. In fact, Marya got quite hung up on the idea of time. "Time is the element in which we exist...We are either borne along by it, or drowned in it" (487). Here Marya reveals her fear that time would destroy her. But she thought that time could help her as well, if she did things right & worked hard. She asked herself, "Wasn't time the precious element that would carry her along to her salvation" (481)? Marya obsessed over the destructive effects of time. Her thoughts about the photographs of the old athletes express her feelings:

Another rowing team. Hopeful young men, standing so straight and tall; their costumes slightly comical; their haircuts bizarre. An air of team spirit, hearty optimism, doom (481).

Marya thinks of doom when she sees this picture because the picture reminds her that those men eventually died. I think Marya expresses this sense of doom in other places in the story as well, like when Phyllis's mother and sister came to clean out Phyllis's room: "And then the waters close over your head.--This phrase ran through Marya's head repeatedly" (491). Marya is thinking her about the doom that overcame Phyllis: doom comes like a flood, then washes you away into oblivion. Marya's obsession over this phrase is a sign that she considered this more than just Phyllis's problem. It was a personal problem for Marya too, because the source of the problem was time itself, something Marya couldn't escape. I believe Marya believes that
"doom" was another word for "time."

THESIS OF 4th PARAGRAPH:

The first problem Marya experiences with the problem of time comes from not having enough of it, so she gets rid of Imogene in order to have more time for work. I think the writing was on the wall from the very beginning of their relationship. In the coffee house with Imogene's friends, when Marya thought she "should have been elsewhere" (481), that other place was back at her room or in the library working. She always felt that "she hadn't...time for 'wasting' on people" (478). In her journal she writes the following words on the subject of friendship: "She hadn't time...she hadn't energy for something so...ephemeral" (483). This last quote points out what really bothered Marya about friendship, that it isn't permanent. Eventually she thought conversations with anyone, whether Imogene or not, wasted her time.

THESIS OF 5th PARAGRAPH:

This sense of impending doom scares Marya, but she has a game plan. Just after she thinks the thoughts about the rowing team, she decides "she really should leave...she shouldn't be here" (481), because she feels this same doom closing in on her, and feels that only through work can she escape it. And the work that could save her is writing. Without writing, she's doomed to destruction like the rowers. But if she could become a writer, she'd have an indestructible existence. We know she believes this when she says "a writer's authentic self...lay in his writing and not his life; it was the landscape of the imagination that endured, that was really real" (474). By becoming a writer she too could have an "authentic self" that "endured." People would read her books long after she'd gone. People would know her "authentic self" long after the end of her "life." So what work she puts into writing is work toward eternity, while what work she puts into friendship is, as she says of sex, "as good a way as any of passing the time" (499). But Marya doesn't want to just pass the time. Marya's quotation of Thoreau expressed her need to avoid such frivolity: "How can anyone kill time without injuring Eternity?" (487)

Step 2: Retype each thesis statement below:

1) 
2) 
3) 
4) 
5) 

What you have here is a reverse outline of the paper. It is called "reverse" because the outline was written after the paper was written. Based on this reverse outline, evaluate the argument of the paper by answering the following questions:

Was there a clear claim for the whole paper stated in the first paragraph?

How did the subsequent subordinate claims support the main claim? In other words, based on your reverse outline, describe how the supporting points that each paragraph brought out supported the main claim for the paper?

Do you get a sense of the progression in the subordinate claims? In other words, can you see how the supporting points follow one from the other?

Step 3: Pick out one paragraph from the paper to examine in further detail.

How has the writer signaled the transition from the previous paragraph to this one?

Evaluate the development & support of the paragraph. How did the details presented support the general claim of this paragraph?

How are the ideas within the paragraph related to each other? In other words, how has the writer tried to make the paragraph cohere, to make it flow together?

Has the writer considered possible objections to the general claim of the paragraph? How?

OPTION 10: EDITING

Although the program has limitations, Word's grammar and spell-check tools can assist students with the
SAMPLE EXERCISE: USING QUOTATIONS

(Alison Tracy)

Make yourself a copy of this file called “quotex.doc” and be sure you are working in your own file. Go ahead and type your answers right into the prompts below.

The following exercise will give you some further practice in using quotations smoothly, effectively, and correctly in your own writing. Select a quote from the following passage to complete each sentence. First, read through the examples carefully.

I am not merely asserting that “We are not all alike.” Those who aren’t aware of that would not likely read this essay or anything like it. What I am saying is that generalizations from within are every bit as fragmenting as scrutiny from without. From my boyhood I have read and heard all manner of statistical facts and figures about black people. Really, they’ve told me very little about who I am, let alone who we are. We’re too big for that, and as individuals too complex. I’m not so sure we should ever find ourselves in the position of saying this general thing or that general thing about black people, expecting our words to discover the essence of our “true self-consciousness,” for when we do, we will be doing no more than talking about black people, talking around them, never quite getting it right, never pinning us down, never quite turning sound into substance, and never—much like the way sharks course around caged divers—ever able to sink our teeth into flesh.

Reginald McKnight, p. 180

Try to use the quotes in several different ways throughout the exercise:

a) Use a signal phrase followed by a comma:

McKnight says,

McKnight claims,

He states,

b) Use your own complete sentence, then a colon, followed by the quotation (which must also be a complete sentence.) Notice that I’ve also left out a brief phrase by inserting the ellipses.

McKnight thinks that negative messages from his own black community are as bad as racist attitudes among other races: “generalizations from within are . . . as fragmenting as scrutiny from without” (180).

Work the quotation right into your own sentence (and here I’ve used brackets to indicate a slight change in wording in his sentence):

He thinks that people who want to pin down “black people” as one thing or the other are like “sharks cours[ing] around caged divers” (180).

You need to be sure you are using the correct methods to add the quote to your sentence. Each sentence can be complete several ways; be sure that whatever way you choose, you use the correct signals and punctuation. You may add words or alter the prompt slightly.

1. McKnight doesn’t want us to think that he is just restating a cliché; he claims,

2. McKnight wants to show that statements made by other black people can be just as harmful as those made by white people:

3. He claims that all of the “facts and figures” he has heard don’t do much to explain his culture to him

4. McKnight wants us to see “black people” not just as a group, but

5. Trying to pin down “blackness” to a certain set of qualities doesn’t do justice to the complicated natures of black individuals

6. McKnight uses the image of sharks biting to explain how vicious people can be about each other
7. He doesn't think words can ever explain our true selves
8. He doesn't want us to continue the mistakes of the past

OPTION 11: GRADING

Students can use Word to develop and modify evaluation rubrics. Creating such rubrics allows students to consider their audience's expectations, and it gives them an active role in the grading process.

SAMPLE EXERCISE: GRADING RUBRIC

(Alison Mandaville)

Rationale: In this exercise students use the Insert Table feature of Word to develop a grading rubric for essays which they will then apply to peer essays and, finally, to their own writing. Students work in groups at the computers to develop the rubric and then can either work in groups or alone to use the rubric to grade each other's work. The nice thing about doing this on the computer is that students can then print out a copy which looks official and which all group members can read. In addition, the rubrics can be used later to project on the overhead for whole class discussion/modification. My students' rubrics are fairly general, but you may also have students make rubrics that are very specific to a particular assignment/topic.

Spending the time making their own chart, agreeing on definitions and criteria for each score and then applying this rubric to their own work is a great way to both examine closely the elements of a good essay and begin to be able to systematically evaluate their own writing. For 104-5 students in particular, I think this exercise is useful in helpful empower students to evaluate their own work and begin to establish some control over their ability to understand and improve their grades. The group aspect reinforces all those good group skills and makes what could be a fairly dry exercise much more fun. There can be some tension around grading each other, so I retain final authority in assigning grades, but find that their grading gets more and more effective the more they do it until sometimes I have few changes to make.

The Exercise: The easiest way to create a table in Word is to use the "Insert Table" icon on the pictorial toolbar. First place you cursor in your document where you want the table to be. Then Left click on the icon that looks like a mini-table with a blue band at the top—the one without an Excel symbol on it. Hold down the mouse as you draw the size of your chart. When your chart is the size you want, release the mouse button, and the chart will drop in where your cursor was.

Students work together (one student creates the table and types in information OR everyone makes their own after agreeing on criteria) to label the chart (terms to define on one axis and scores on the other) and define the criteria for scoring an essay. The terms you ask them to define will depend on what you've been working on—you may ask them only to do one or two to start, adding another criteria with each assignment.

Students work to evaluate a draft of each other's essays based on their own rubrics.

Large group discussion following the group exercise can help fill out individual groups' charts and pinpoint areas of fuzziness re: writing criteria.

NOTE: Resist the impulse to create the chart for the students because first, it's good to know how to make a chart, and second, the terms you ask them to define, and the scale you ask them to use will become much more firmly entrenched if you have them set it all up.

OPTION 12: REFLECTION

At the end of an assignment sequence, you can ask create a short reflection exercise that allows students to reflect upon both their essay and the usefulness of activities in the sequence. Students can type their responses into the document and save the file to an evaluation folder.

SAMPLE EXERCISE: REFLECTING ON THE WRITING PROCESS

(Kimberlee Gillis-Bridges)

1. How did the process of writing this essay help you to develop as a cinema studies thinker and writer? Did comparing and contrasting two films give you any insight into patterns and shifts in the horror genre?
2. Which elements of your first draft (thesis paragraph, use of evidence, organization, etc.) did you revise most extensively? How have those revisions made the essay stronger?

3. If you could still revise your essay, what would you revise? Why?

4. Which aspects of the writing process for this essay did you find easy? Which did you find difficult? Why?

5. Please offer a grade for each of your peer reviewers, using the following scale and explaining to what extent each reviewer’s comments helped you to revise.

   **Plus:** An extremely useful evaluation
   **Check:** A mostly useful evaluation
   **Minus:** Not very useful overall (perhaps not complete)

<table>
<thead>
<tr>
<th>Reviewer 1:</th>
<th>Reviewer 2:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grade:</td>
<td>Grade:</td>
</tr>
<tr>
<td>Reasons:</td>
<td>Reasons:</td>
</tr>
</tbody>
</table>

6. How did the process of reviewing other writers’ work influence your revision process?

7. Was the flexibility of the peer critiquing method (paper, Word) useful? Do you have any suggestions for organizing the peer critique process for Essay #3?

8. Did issues discussed in the conference and my comments on your paper or Web site help you to revise your work? Why or why not?

9. Which activities and homework (responses, brainstorming sheet, discussion of lecture arguments and responses, in-class clip analyses and comparison presentation, essay workshop) did you find most and least helpful in writing your first draft? Why?

10. What types of activities and homework would you like to do in preparation for our next paper, an analytical essay that incorporates research?

**USEFUL ADVANCED FEATURES**

Word is a powerful program with more features than it is possible to cover in a manual of this scope. However, the following table highlights some of the features available through Word 2007 that are most useful in a writing classroom. More extensive information on how to use these features can be found in the on-line Word Help menu and in the sample exercises in this manual that make use of these features.
<table>
<thead>
<tr>
<th>What It Is</th>
<th>What It Does</th>
<th>Where to Find It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comments</td>
<td>Inserts comments in boxes next to the text. Useful for peer reviews and for on-screen instructor commenting. See sample peer editing exercise for an example.</td>
<td>Select Comment from the Review menu.</td>
</tr>
<tr>
<td>Auto-</td>
<td>Automatically generates an abstract of a paper. Allows students to adjust the percentage of text included in abstract. Can be a useful way to demonstrate organizational and structural problems in papers.</td>
<td>Select Auto Summarize from the Tools menu.</td>
</tr>
<tr>
<td>Summarize</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Outline</td>
<td>Allows students to move sections of an argument to other locations and to visualize the organizational structure of a draft. Useful in pre-writing and revision exercises.</td>
<td>Select Outline from the View menu.</td>
</tr>
<tr>
<td>View</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Track</td>
<td>Maintains and displays a visual record of recent editorial changes to a document and can even print this record out. Useful for peer editing and writing workshops, especially when used with the projector.</td>
<td>Select Track Changes from the Review menu.</td>
</tr>
<tr>
<td>Changes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Highlight</td>
<td>Allows students and instructor to block text out with a range of different bright colors. Useful in writing workshops with the projector. Instructor can assign different meanings to different colors.</td>
<td>Click the highlighter icon on the Home toolbar, select a color, and highlight selected text.</td>
</tr>
<tr>
<td>Document</td>
<td>Displays a split screen. A brief outline appears on the left, while the text of the paper appears on the right. Useful tool for longer arguments and research papers.</td>
<td>Select Document Map from the View menu, or click on its icon on the tool bar.</td>
</tr>
<tr>
<td>Map</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Department of English · University of Washington · A101 Padelford Hall, Box 354330 · Seattle, WA 98195-4330
Main Office: (206) 543-2690 · Advising: (206) 543-2634

Copyright © 2016-2019 University of Washington · Privacy · Terms · Site Map · Contact Us

Source URL: https://english.washington.edu/teaching/teaching-microsoft-word